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Sima is a simulation and analysis tool for marine
operations and floating systems — from modelling to
post-processing of results.
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DOCUMENTATION

Installation instructions

Required:

e 64 bit Windows 7/8/10

¢ 4 GB RAM available for SIMA (e.g. 8 GB RAM total in total on the computer)
* 1 GB free disk space

» Updated drivers for graphics card

Note that Windows Server (all versions), Windows XP, Windows Vista, and any 32-bit Windows are
not supported.

Recommended:

* 64-bit Windows 10

* 16 GB RAM

e Fast quad core processor (e.g. Intel i7)

e High-resolution screen (1920 x 1200 / 1080p)

e Graphics card: DirectX 10.1 or 11.X compatible; 512 MB or higher

e Fast SSD disk, as large as possible (capacity requirements depends heavily on simulation
settings, e.g. 500 GB is a good start)

¢ 3-button mouse

High disk speed is important if running more than 2 simultaneous simulations in parallel.
Example: If the user has enough SIMO-licenses and has configured SIMA to run 4 SIMO-
calculations in parallel, then the simulations will probably be disk-speed-bound, and not CPU
bound (with the above recommended hardware). Note that this is heavily dependent on the
simulation parameters, so the result may vary. The default license type should now allow for
unlimited parallel runs on one PC, workstation of cluster.

Updated Drivers for Graphics Card

The driver of the graphics card should be upgraded to the latest version. This is especially
important if you experience problems with the 3D graphics. Note that the version provided by
Windows update is not necessarily up to date - download directly from your hardware vendors
web-site.

Installing graphics drivers may require elevated access privileges. Your IT support staff should be
able to help you with this.

SIMA should work with at least one graphics-mode (OpenGL, OpenGL2, DirectX 9 or DirectX 11)
for all graphics cards that can run Windows 7 or 8. However, graphics cards can contain defects
in their lower-level drivers, firmware and/or hardware. SIMA use the software “HOOPS” from the
vendor “Tech Soft 3D” to draw 3D-graphics. For advanced users that would like more information
on what graphics cards and drivers that does not work with SIMA (and an indication on what
probably will work), please see the web page http://developer.techsoft3d.com/hoops/hoops-
visualize/graphics- cards/ .

Before reading the compatibility table you may want to figure out which version of HOOPS SIMA
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is using. To do this open Help > About > Installation Details, locate the Plug-ins tab and look for
the plug-in provider TechSoft 3D (click the Provider column title twice for a more suitable sort
order). The version number is listed in the Version column. Also remember that all modes
(OpenGL, OpenGL2, DirectX 9, DirextX 11) are available in SIMA.

Upgrading from Earlier Versions

After upgrading to a newer version of SIMA, your workspaces may also require an update. This
will be done automatically as soon as you open a workspace not created with the new version. You
may not be able to open this workspace again using an older version of SIMA.

Preference settings should normally be retained after upgrading, however you may want to open
the preference dialog ( Tools > Preferences ) in order to verify this.

Verify Correct Installation
To verify a correct installation of SIMA, perform the following steps:

1. Start SIMA (by the shortcut created when installing, or by running the SIMA executable)

a. If you are prompted for a valid license, specify a license file or license server. (If you need
advanced information on license options, see “License configuration”).

b. SIMA auto-validates upon startup: A successful installation should not display any errors
or warnings when SIMA is started.

2. Create a new, empty workspace:

a. You will be prompted to Open SIMA Workspace: Create a new workspace by clicking New,
select a different folder/filename if you wish, and click Finish.

3. Import a SIMO example, run a SIMO simulation, and show 3D graphics:
a. Click the menu Help > Examples > SIMO > Heavy lifting operation
b. Expand the node Condition in the Navigator in the upper left corner

c. Right-click Initial, and select Run dynamic analysis. After a few seconds, you will see the
message Dynamic calculation done. No errors should occur.

d. Right-click HeavyLifting in the Navigator in the upper left corner, and select Open 3D
View. 3D-graphics should be displayed, showing a platform and a crane.

4. If there were no errors when doing the above steps, then SIMA can be assumed to be
correctly installed.

Changing Default Workspace Path Configuration

When creating a new workspace SIMA will normally propose a folder named Workspace xx where
xx is an incrementing number; placed in the users home directory under SIMA Workspaces.

The proposed root folder can be changed by creating a file named .simarc and place it in the
users home directory or in the application installation directory (next to the SIMA executable).
The file must contain a property sima.workspace.root and a value. For example:

sima.workspace.root=c:/SIMA Workspaces/

A special case is when you want the workspace root folder to be sibling of the SIMA executable.
This can be achieved by setting the property as follows:

sima.workspace.root=.
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License Configuration
SIMA will attempt to automatically use the license files it finds in this order:

Use path specified in the file “.simarc” if present. See details below.
Use the path specified in the license wizard.

Use the system property SIMA LICENSE FILE.

Use the environment variable SIMA LICENSE FILE.

Use all “*.lic” files found in C:/flexlm/ if on Windows.

S T S e

Use all “*.lic” files found in the user home directory.

If any of the above matches, the search for more license files will not continue. If there are no
matches, SIMA will present a license configuration dialog.

The license path can consist of several segments separated by an ampersand character. Note that
a license segment value does not have to point to a particular file - it could also point to a license
server. For example:

c:/licenses/sima.lic&1234@my.license.server&@another.license.server

In this case the path is composed on one absolute reference to a file. Followed by the license
server at port 1234 and another license server using the default port number.

RIFLEX and SIMO License

When  starting SIMO and RIFLEX from SIMA  the environment  variable
MARINTEK LICENSE FILE will be set to the home directory of the user. This means that a
license file can be placed in this directory and automatically picked up.

Specifying a License path

When starting SIMA without a license the dialog below will pop up before the workbench is
shown. If you have a license file; you can simply drag an drop it into the dialog and the path to
this file will be used. You may also use the browse button if you want to locate the file by means of
the file navigator. If you want to use a license server; use the radio button and select License
server then continue to fill in the details. The port number is optional. A host must be specified,
however. Note that the host name must be in the form of a DNS or IP-address.
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'ﬁ' Missing or invalid FLEXIrm License
Specify license location

€3 License for the SIMA Core module is missing, expired or invalid.
Please select a new file containing valid licenses.

= [@]=]

Source;

@ Local file i) License server
Local file:

File location:

License server:

Port and address: 1]

< Back Mext = Finish

Cancel

'ﬁ Missing or invalid FLEXIrm License
Specify license location

Specify or drag and drop a license file into the dialog, alternatively
specify a license server

= [@][=]

Source;

@ Local file i) License server
Local file:

File location: ChUsers\andreasa\marintek_sima_intern_2016.lic

License server:

Port and address: 31]

< Back Net> ||  Finish

] ’ Cancel

You can now press Finish or if you want to add more path segments; you can press Next, this will
bring up the second page of the license specification wizard. The page will allow you to add and
remove licence path segments and rearrange their individual order.

Modifying a License Path

If the license path must be modified it can be done using the dialog found in the main menu;
Window >Preferences > License. This preference page works the same as the second page of the

wizard.

| Sesam Release Note | Sima V4.2.0 | www.dnv.com/digital

Page 6



Specifying License Path in .simarc

The mechanism described here works much like specifying the environment variable, however it
will also lock down the SIMA license configuration pages, thus denying the user the ability to
change the license path. This is often the better choice when installing SIMA in an environment
where the IT-department handles both installation and license configuration.

The license path can be forced by creating a file named .simarc and place it in the users home
directory or in the application installation directory (next to sima.exe). The latter is probably the
better choice as the file can be owned by the system and the user can be denied write access. The
license path must be specified using the sima.license.path key and a path in the FLEXIm Java
format. The license path can consist of several segments separated by an ampersand character.
For instance:

sima.license.path=c:/licenses/sima.lic&1234@my.license.server&@anotherlicense.server

Note that the version of FLEXIm used in SIMA does not support using Windows registry variables.
It also requires the path to be entered in the FLEXIm Java format which is different from the
normal FLEXIm format. Using this mechanism one can also specify the license path for physics
engines such as SIMO and RIFLEX started from SIMA. This is done by specifying the key

marintek.license.path followed by the path in normal FLEXIm format. For example:

marintek.license.path=c:/licenses/ sima.lic:1234@my.license.server:@anotherlicense.server

Viewing License Details

If you would like to view license details, such as expiration dates and locations you will find this in
the main menu Help > License.

- "

¥ License Details @

@B FlexLm license at "ChUsers\andreasalmarintek_sima_intern_2016.lic"

~ 4

Core Features
Provisional Features
SIMA RigPes

SIMIA SinDrill

T v
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NEW FEATURES
New Features - SIMO

Release Note

Reference

Option to calculate retardation function from added mass and damping
added to plot editor

SIMA-9812

Fluctuating 3-comp wind, IECWind format (DTUMann)

The default value for number of slices in core has been increased from 10 to
800. This is expected to increase the CPU efficiency when the IECWind
(DTUMann) format is used in the analysis.

SRV-1688

When using parametric wind spectra in coupled analysis the wind velocity
time series is now reported for the hub position. Previously the wind velocity
time series were reported for the reference height of the wind coefficients.

Wind velocity for turbine blades will now be computed by taking the blade
element vertical position into account. Previously the wind velocity at wind
coefficients reference height was used for all blade elements.

This means that results will change slightly compared to older versions.
The new behavior is consistent with how other calculations are made with

other wind types, i.e. Stationary Uniform, Fluctuating two and three
component wind types.

SRV-1749

The Constant Tension Control in Simple Wire Coupling now has input to
specify activation time and deactivation time.

SRV-1685

New Features - RIFLEX

Release Note

Reference

Combined blade pitch, electrical power and yaw control system

The external wind turbine control system may now also include Nacelle yaw
control. Currently only one wind turbine can have an external control system.

SRV-1768

A hydrostatic/hydrodynamic load model that accounts for partially
submerged cross section has been made available for thin-walled pipe cross
sections (CRSO0), axis-ymmetric cross sections (CRS1) and double symmetric
cross sections (CRS2) as a new hydrodynamic load type. This load model is
available for both beam and bar elements and may be used in dynamic
analyses with regular or irregular waves. Both lumped and consistent
formulations are available.

The new load model will give similar results to the existing partly submerged
cross sections (CRS3 and CRS4) which could not be combined with irregular
waves.

SRV-1706

Several options for controling MatrixPlot storage has been added to static
calculation parameters in RIFLEX

SIMA-9552
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Release Note Reference

Eigen value analysis can be performed for cross section with MacCamy & SRV-1729
Fuchs wave loads

Add TD VIV load for CRSO cross-sections SRV-1758

Storage of dynamic results for seafloor and soil contact elements SRV-1713

An option has been added to toggle storage of results for seafloor and soil
layer profile (SLP) contact elements.

These results are available from nonlinear simulations only. If storage is
specified, they will be stored for all seafloor / soil contact elements attached
to beam or bar elements for which force storage is specified.

The results were previously exported if force storage on an additional file
was specified; i.e. if IFORFM was nonzero. The results will now be exported
if the new option IBOTFM is nonzero.

The default is no storage of seafloor / soil contact results, so the input file
must be changed if these results are wanted.

Fluctuating 3-comp wind, IECWind format (DTUMann) SRV-1688

The default value for number of slices in core has been increased from 10 to
800. This is expected to increase the CPU efficiency when the IECWind
(DTUMann) format is used in the analysis.

An option have been added to allow the added mass and damping to be given | SRV-1728
in non-dimensional format for the MacCamy & Fuchs wave loads.

Improve error message using tabulated spectrum and too large time |SRV-1440
step.

Too large time step gives a Nyquist frequency smaller then the largest
frequency in the tabulated spectrum. The error message is improved.

Time domain VIV load for stress joint (Restricted functionality) SRV-1787

Time domain VIV load model is available for stress joints.

Option for calculation of arclength for result presentation SRV-1417
The user may now choose whether the arclength is accumulated throughout
the whole system or starts at zero for each line. The arclength was previously

always accumulated over all lines.

In SIMA the default is to start at zero for each line. In standalone RIFLEX the
default

is to accumulated the arclength throughout the system.

The arclength is mainly used for results on the MatrixPlot files.
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Release Note Reference
Hydrodynamic load model for loads acting on nets SRV-1755
A hydrostatic/hydrodynamic load model that accounts for loads acting on a

net panel has been made available for axisymmetric cross sections (CRS1).

This load model is available for bar elements only. Both lumped and

consistent formulations are available, and the load type may be used in

dynamic analyses with regular or irregular waves.

The load formulation is based on the Fish net cross section (CRS6) and can

now be used with irregular waves.

Include hydrostatic stiffness in eigenvalue analysis SRV-1824
The hydrostatic stiffness of beam and bar elements crossing the surface is

now included in eigenvalue analysis.

If there is a wind turbine and there is a turbulent wind field, a warning is SRV-1626
printed to the <*>.lis /<*>.res files if the rotor is not within the turbulent

wind field.

Added support for RIFLEX internal flow from file SIMA-9660
New Features - Other

Release Note Reference
New Help system SIMA-9340
The SIMA help system has been replaced. The help will now open in an

external web browser

A batch version of SIMA (SIMA Runtime Engine) is now delivered together SIMA-9828
with the official version of SIMA with UI. This is made available on both

Linux and Windows.

This makes it possible to run SIMA on environments without a user interface

such as clusters and in cloud environments.

Start the sre executable with --help to get an overview of commands

available

SIMA Python library SIMA-9799

A SIMA Python library (SIMAPY) has been developed to enable creation of
model elements using script. This library will create json-files that in turn can
be imported into SIMA. It is also possible to export json from SIMA which in
turn can be used to initialize Python objects for further manipulation.

pip install simapy
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BUG FIXES
Fixed bugs - SIMO

Release Note

Reference

When using Slender Elements and Fixed Body Elements with the option
"Gravity and buoyancy NOT included", added mass was not computed for
these and potentially other elements on that body.

This error has now been resolved and added mass is now computed for all
Slender Elements and Fixed Body Elements regardless of this option.

Longstanding error.

SRV-1793

An error message have been added in SIMO preventing field points to have
only diffracted wave elevation, without the associated diffracted wave
particle velocity. In previous versions, having only wave elevation was
allowed, but caused erroneous diffracted wave elevation.

SRV-1803

The grid coordinates are now consistent with Turbsim when the grid height
is larger than the grid width.

SRV-1786

Using a Numerically Defined Wave Spectrum and the Cosine Wave Method

Longstanding error.

would previously not give any wave realization. This has now been resolved.

SRV-1725

If an external control system returned feedback values very close to zero
(absolute value less than approximately 1.0e-308), Riflex would incorrectly
interpret these values as invalid. This has now been resolved.

Error since Sima 4.1.0.

SRV-1721

Bladed style controllers for wind turbines did previously not work with the
Simo wind turbine. This has now been resolved.

SRV-1797

Fixed issue where SIMA read two hydrodynamic couplings for each pair of
bodies from SIF file

SIMA-9677

Fixed bugs - RIFLEX

Release Note

Reference

The grid coordinates are now consistent with Turbsim when the grid height
is larger than the grid width.

SRV-1786

Using the SIMO feature Generic External Control System would previously
cause RIFLEX to terminate with an error. This has now been resolved.

SRV-1735

Visualization using regular waves in coupled analysis did not work. This is
fixed.

SRV-1722

Fixed error related to the stored forces and displacement time series which
caused the DNC OS F-201 capacity check to fail

SIMA-9814
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Release Note Reference

Error in printing diffracted kinematics points to Dynmod result file is SRV-1772
corrected. The incorrect points was listed. The error is related to the print
only.

Fixed import and export of diffracted wave input in RIFLEX SIMA-9741

Wind turbine static analysis. SRV-1724

If a wind profile was defined and the wind load group is not activated in the
static loading, the static parameter variation failed.

This is corrected.

Wind turbine blade response storage SRV-1771

Corrected an error that could occur for multiple wind turbines. If more blade
elements were specified for blade storage than the number of blade elements
in the last specified wind turbine, the simulation could fail.

Corrected an error in some results for the last, i. e. outermost, element of a
blade: - Annulus average axial induced wind in rotor system - Annulus
average tangential induced wind in rotor system - Annulus average axial
force in rotor system - Annulus average tangential force in rotor system
These results are only stored if medium or maximum blade storage is
specified.

Wasim export did previously cause an error when combined with VTF SIMA-9693
visualization. This has now been resolved.

Nodal body added mass contribution to Rayleigh damping SRV-1745

If additional mass for a nodal component attached to a bar element was
specified in global system, the added mass contribution to Rayleigh damping
was not included. This has been corrected.

Note that mass proportional damping will dampen rigid body motions and is
therefore normally not used.

Multiple wind turbines with and without nacelle yaw control SRV-1799

A possible error in analyses in which some turbines had nacelle yaw control
and some did not has been corrected. A wind turbine without nacelle yaw
control could turn off yaw control for subsequent wind turbines.

Fixed bugs - Other

Release Note Reference
Fixed error when zooming in plotting library SIMA-9708
Fixed issue when changing name of master super node in table from SIMA-9679
clipboard
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Release Note Reference

Internal nacelle yaw control SRV-1807

Corrected the scaling of the input yaw threshold for the internal yaw
controller. User input is given in (deg”™ "2 s) and was scaled with pi/180
instead of with (pi/180)**2.

Incorrect pointer caused error in eigen value analysis with multiple bodies SRV-1820
(coupled analysis).

Longstanding error.

Fixed issue where error free condition was blocked to run when other SIMA-9675
conditions had validation errors

Error in visualization of line segments with offset and twist has been fixed. SIMA-9787

Fixed selection of external jar controller for wind turbines SIMA-9768
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REMAINING KNOWN ISSUES

Unresolved Issues - SIMO

Release Note

Reference

The Nonlinear Buoyancy Correction feature is deprecated and will be
removed in the next release. Please use Nonlinear Hydrostatic Stiffness
instead.

SRV-1609

Unresolved Issues - RIFLEX

Release Note

Reference

Local axes for wind turbine blades without twist or bend

The default local axes method for wind turbine blades is not followed if the
blade line is not pre-bent or pre-twisted. Long-standing error.

Workaround: use local element axes for the wind turbine blades or define a
negligible, but non-zero twist or bend for the blade line type.

SRV-1583

Unresolved Issues - Other

Release Note

Reference

Some users have experienced font issues in the report and/or the plots after
a windows 10 update. A workaround is to change the font for the plots.

SIMA-8668

SIMA crashes in some cases when screen-saver starts or an external screen
is connected and SIMA window is opened. If this occurs the user should test
alternative graphics drivers in settings and turn of screen-saver.

SIMA-7090
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ABOUT DNV

Driven by our purpose of safeguarding life, property and the environment, DNV enables
organizations to advance the safety and sustainability of their business. We provide classification
and technical assurance along with software and independent expert advisory services to the
maritime, oil and gas, and energy industries. We also provide certification services to customers
across a wide range of industries. Operating in more than 100 countries, our 16,000 professionals
are dedicated to helping our customers make the world safer, smarter and greener.

DIGITAL SOLUTIONS

DNV is a world-leading provider of digital solutions for managing risk and improving safety and
asset performance for ships, pipelines, processing plants, offshore structures, electric grids,
smart cities and more. Our open industry platform Veracity, cyber security and software solutions
support business-critical activities across many industries, including maritime, energy and
healthcare.
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